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INTRODUCTION TO DB OPTIMIZER

Embarcadero DB Optimizer simplifies SQL optimization and development with many features
for improving productivity and reducing errors. A rich SQL IDE with statement tuning, data
source profiling, code completion, real-time error checking, code formatting, and sophisticated
object validation tools helps streamline coding tasks. DB Optimizer's user interface helps
improve overall productivity with integrated development, monitoring, and tuning components.
DB Optimizer offers native support for IBM® DB2® for LUW, Oracle®, Microsoft® SQL Server
and Sybase® as well as JDBC support for other DBMS. It is available as a stand-alone
application, or as an Eclipse plug-in. DB Optimizer is structured and composed into three main
interface parts. This design provides a comprehensive workflow that enables development,
query analysis, and tuning capabilities. This workflow, in turn, leads to more efficient task
management in terms of time and efficiency, overall.

ABOUT THIS DOCUMENT

This document helps you install DB Optimizer and introduces you to the basic functionality of
DB Optimizer.

NOTE: For the latest versions of DB Optimizer documents and for information that will help
you install and upgrade, including technical requirements and databases supported,
see the Embarcadero documentation website. Always make sure to consult the
README for late breaking updates at docs.embarcadero.com/products/db_optimizer.

MAJOR INTERFACE COMPONENTS

The three major interface components of DB Optimizer are as follows:

SQL Profiler: Provides continuous data source monitoring that builds a statistical model or
profile, of the specified data source, and highlights top SQL, event, and session activity. This
component is used to locate and diagnose problematic SQL code and event-based bottlenecks
via its graphical interface, which is used to identify problem areas and drill down to individual,
problematic statements. Additionally, Profiler enables the investigation of execution and wait
time event details for individual stored routines. Profiling Details of the SQL Profiler have been
expanded to show Session Details for Sybase, and SQL Server and the SQL that ran in the
selected session for Sybase, SQL Server, and DB2.
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Limitations of the Trial Version

SQL Tuner: Provides an easy and optimal way to discover efficient paths for queries that may
not be performing as quickly or as efficiently as they could be. Tuner enables the optimization of
poorly performing SQL code through the detection and modification of execution paths in data
retrieval through hint injections. Users are supplied with a list of possible cases generated by
Tuner, and can select and update a statement with the most efficient path to reduce load and
improve efficiency, overall. The Analysis tab of the tuner provides a graphical diagram of an SQL
query to show how the tables in the query would be joined to satisfy the query and also provides
suggestions for the creation of indexes that may increase query performance.

SQL Editor: Simplifies SQL development by utilizing features that improve productivity and
reduce errors. It provides a rich interface that offers code completion, real-time error checking,
code formatting, and sophisticated object validation tools. In context with SQL Profiler and SQL
Tuner, it provides an interface for viewing and editing SQL files and database packages, as
accessed through Profiler and Tuner functionality.

LIMITATIONS OF THE TRIAL VERSION

The following limitations apply to the trial version of DB Optimizer. These limitations are
removed once the product has been purchased.

e Command line profiling and tuning are not available.
e There are a limited number of profiling sessions you can run.

* Profiling is limited in that you will not be able to see the captured SQL text of the data
source profiled.

® Only the Ad Hoc SQL tab is available for specifying tuning sources. You cannot tune
database objects, SQL files or the Oracle SGA.

e There are a limited number of statement extractions from the profiler to the tuner.

* In the tuning editor the following case actions are disabled: Clone Case, Edit Case, and
Create Custom Case.

LIMITATIONS OF DB OPTIMIZER XE DEVELOPER

The following features are not supported on DB Optimizer XE Developer:
e Visual SQL Tuning.
e Hint analysis via SQL hint injection for Oracle data sources.

e Saving profile sessions to an Oracle data source repository.
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INSTALLATION

This section helps you install DB Optimizer. It is comprised of the following topics:

e Installation Issues on page 7

¢ Installing DB Optimizer on page 7

NOTE: Forinformation oninstalling DB Optimizer XE, which includes Embarcadero AppWave,
please see the AppWave Quick Start Guide and the AppWave Administrator Guide at
docs.embarcadero.com/products/appwave.

TECHNICAL REQUIREMENTS

For information on the technical requirements of DB Optimizer, including supported operating
systems and databases supported, see the Readme at docs.embarcadero.com/products/

db_optimizer.

INSTALLATION ISSUES

DB Optimizer should be installed in a different directory than previous versions of DB Optimizer.
If DB Optimizer is installed in the same directory, the following error will result in at application
start up: “Unable to read workbench state. Workbench Ul layout will be reset.”

If a previous version is already installed on your machine, either change the default Workspace
or delete all files from the Workspace directory. The Workspace directory location appears
whenever you start DB Optimizer, and can be redefined from this dialog box. If the same
Workspace is indicated for the new version as was indicated previously, the following error will
result: “Cannot restore workbench layout”.

If DB Optimizer is already running, you can also modify the Workspace directory by choosing
File > Switch Workspace > Other from the Main Menu.

INSTALLING DB OPTIMIZER

To install DB Optimizer, run the installer and follow the prompts provided by the Installation
Wizard. When the installation is complete, review the Readme file to check if it contains any
known issues or advisory notes that will affect your installation of the product.
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Installing DB Optimizer

INSTALLING DB OPTIMIZER ON LINUX

1

10

Download the DB Optimizer installer and set the execution permissions as follows:
chmod 755 dbo <version>.bin

Launch the installer in GUI mode from the console.

./dbo_<version>.bin

The DB Optimizer splash screen appears for a short time and afterwards the installer dialog
appears.

On the Introduction dialog, click Next.

On the License Agreement dialog, read the License Agreement, select “| accept the terms
of the License Agreement” and then click Next.

On the Choose Install Set dialog, choose one of the two options and click Next.

Install as Standalone Application: This option installs DB Optimizer as a Standalone
Application, without any prerequisites.

Install as Eclipse Plug-in: This option requires Eclipse 3.5 or higher or an Eclipse Based RCP
application.

On the Choose Install Folder dialog, depending on the previously selected option, you can
select a destination folder where to install the Standalone version or, you are required to
browse to the folder that contains Eclipse 3.6 (or higher) or an RCP application based on
Eclipse 3.6.

After selecting the desired folder, click Next.

On the Choose Link Folder dialog you can change the location where the Application/
Uninstall links are created. Choose one of the options and click Next.

On the Pre-Installation Summary, review the installation details and click Install.

The Installing dialog shows the progress of the installation; it is closed when the installation
is complete.

When the Install Complete dialog appears you can select Start Embarcadero DB
Optimizer if you want to start the application for a first time use and click Done.

LICENSING DB OPTIMIZER
DB Optimizer supports the following types of licenses:

e Trial licenses: A license for a 14-day, full-featured trial version of the product. The trial

license must be registered before you can use the product. For more information, see
"Registering a Trial or Workstation License at Application Startup" on page 9.
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Installing DB Optimizer

o Workstation or Network Named licenses: A license or set of licenses that is tied to a

particular workstation. The product can only be used on that workstation. For more
information, see "Registering a Workstation License after Application Startup" on page 9.

Concurrent Licenses: If you are using AppWave and DB Optimizer you can also have
concurrent licenses which are floating licenses that allow a specific number of users to
concurrently use a license, without tying the license to a specific workstation serial number.
For more information, see the “Licensing” section of the AppWave Administrator Guide.

If you have problems registering, see "Registering by Phone" on page 10.

Registering a Trial or Workstation License at Application Startup

Shortly after downloading a trial version of an Embarcadero product, you should receive an
email from Embarcadero with a serial number, which must be registered as follows. These
instructions also apply if you have purchased a product and received a serial number prior to
running the application for the first time, or if the trial period has expired.

1

Start the application.
The Embarcadero License Registration dialog appears.
Copy the serial number from the email, and then paste it into the Serial Number field.

Enter your Embarcadero Developer Network (EDN) account credentials in the Login or
Email and Password fields.

If you have not previously created an EDN account, or have forgotten your password, click |
need to create ... or I've lost my password.

Click Register.

The activation file should be downloaded and installed automatically. If this does not
happen, click the Trouble Connecting? Try Web Registration link and follow the prompts.
If you still have problems, see "Registering by Phone" on page 10.

Registering a Workstation License after Application Startup

The following instructions assume that you have received a workstation license by email and that
you currently have a valid trial license. If you did not install a trial version or if the trial period has

expired, follow the instructions in "Registering a Trial or Workstation License at Application
Startup" on page 9 instead.

1
2

Click Help > Launch License Manager.
In the License Manager dialog, click Serial > Add.

Copy the serial number from the email, paste it into the Add Serial Number dialog, and
then click OK.
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Installing DB Optimizer

4

Expand Unregistered Serial Numbers, right-click the serial number just added, and then
click Register.

A registration dialog appears.

NOTE: The Registration Code box shows a machine-specific identifier required with other
registration methods.

Ensure that Register using Online Registration is selected.
Provide Developer Network credentials in the Login or Email and Password fields.
Click Register.

The activation file should download and install automatically. If this does not happen, click
the Trouble Connecting? Try Web Registration link and follow the prompts. If you still
have problems, see "Registering by Phone" on page 10.

Registering by Phone

If you have problems with either of the above procedures, you can register licenses by phone.
You must provide the following information:

e Embarcadero Developer Network credentials

e The registration code displayed in the Embarcadero License Registration dialog that

appears when you start an unlicensed application

e The product base license serial number

® The license serial numbers for any additional features you have purchased.

For North America, Latin America, and Asia Pacific: call (415) 834-3131 option 2, and then follow
the prompts. The hours are Monday to Friday, 6:00 A.M. to 6:00 PM. Pacific time.

For Europe, Africa, and the Middle East: Call +44 (0)1628-684 494. The hours are Monday to
Friday, 9 AM. to 5:30 PM. U.K. time.

Shortly after phoning in, you will receive an email containing an activation file. Then do the
following:

1

2
3
4

10

Save the activation file to the desktop or to a scratch directory such as c:\temp.
From within the application, click Help > Launch License Manager.
Click License > Import.

Navigate to the directory where you saved the activation file, and then double-click the
activation file.

Click the Import button to import the activation file, and then click Finish.
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GETTING STARTED WITH DB OPTIMIZER

The following tutorial sessions enable you to get started using DB Optimizer. Their purpose is to
provide you with the foundation needed to fully utilize the features and benefits of DB
Optimizer, and apply them to your own enterprise. This section contains information on how to
register data sources from your enterprise, and how to profile, analyze, and tune SQL
statements, sessions, and events for the purpose of optimizing the efficiency of your data
sources, as well as identify and prevent system bottlenecks and other wait-related issues.

This guide is comprised of the following sections:

e Start DB Optimizer on page 11

Overview of the User Interface on page 12

Working with Data Source Explorer on page 14

Profiling a Data Source on page 19

Tuning SQOL Statements on page 28

SQL Code Assist and Execution on page 48

START DB OPTIMIZER

From the Desktop, choose the Windows Start menu and then select Programs >
Embarcadero > Embarcadero DB Optimizer X.X > Embarcadero DB Optimizer X.X.

NOTE: Once you have started the application, you can select Help from the menu bar to find
additional resources that complement and build upon the features and tasks presented
in this guide.
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Overview of the User Interface

OVERVIEW OF THE USER INTERFACE

The DB Optimizer application environment is known as the Workbench that provides an
interface through which you manage data sources and analyze and tune statements. The
Workbench is composed of common interface elements that provide tools to accomplish these
tasks. These objects provide a uniform system for working with tuning jobs, profile sessions, and
data sources.

& SOL - test/Matt.tun - Embarcadero DB Optimizer XE2 Pro - C:\Wocuments and SettingstJacquietdb
File Edit Mawigate Search Project Bun Window  Help

i R EES (BRSO A

99 pata Source B2 5% 5L Project | O || 59 Untitled SGL.sq) |Z] Matbbun 53 W] TORLABSCORCL (MO

g B =% 7k i orade b P TORLABSCORCL (MOVIES) (10.2.0.1)

| | L-* Overview FF' Analysis
[= T=F Managed Data Sources (13) ~

[=I-1=F Data Source Group (100 EE Qverview
I=F Microsoft SQL Server (3

== Oracle (7) Tuning Statement: GEnerate cases []Perfarm det

Efs| ROMLABORCLEI_1 (Orarle
8| ROMLABORCLSI_2 (Oracle R
j’j sFwpclb0l .embarcadero. cor SHEMEN
il TORLABORCLEI 2 (Oracls _ 1EE Schema Uists
jg!_l TORLABORCLSI 1 (Oracls E [#]=ELECT 1 MOYIES select From
= % TORLABSCORCL (MOVIES) g SELECT 2 MOYIES select From

=% ) o FAsFiFrT = NS calart Framm

=-Li3 Database Objects <

E‘_;Lr Check Constrainks
geg Clusters

2L Dakabase Links Generated Cases

E_g Directaries S0L Statements and Cases

'.‘}‘3 Foreign Keys Name Text
f_" Functions + M SELECT 1 select From MOYIES, customer,
& Groups Bl & sEEcT 2 select From MOYIES, customet,
Indexes + J& SELECT 3 select From MOVIES. customer,
(@ Java Classes + J SELECT 4 select From MOVIES. customer,
b JavaResources + & SELECTS select From MOVIES. customer,
B Java Sources + S SELECT 6 select From HR.EMP_DETAILS .
[5] Jobs + J SELECT 7 select Fram MOVIES, custamer,
‘III Libraries

—_— s . .

The Workbench provides an environment to build profiling sessions and tune query statements.

The Workbench Space is composed of views, editors, and the menu bar and command toolbar.
Views and editors enable you to perform DB Optimizer functions and work tasks, as well as
manage resources.
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Overview of the User Interface

e Views are used to navigate a hierarchy of information, open Editors or display the properties
of various application elements. For example, the Data Source Explorer view provides a tree
of all data sources in the environment and the comparison jobs associated with each. You
can launch these jobs directly from Data Source Explorer, modify the connection properties
of data sources, or create and edit configuration archives from this View.

e Editors are used to access DB Optimizer functionality. For example, the SQL Editor
provides a means to view, edit, and save SQL code. Editors are differentiated from Views in
that they operate on an individual level rather than a supportive one. The SQL Profiler and
SQL Tuner are also considered to be editors.

® The Menu Bar and Command Toolbar contain commands that execute various functional
aspects of the application such as launching views and editors, navigation commands, and
environment preference settings. The command toolbar contains icons that represent
specific menu commands.
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Overview of the User Interface

WORKING WITH DATA SOURCE EXPLORER

Data Source Explorer provides a tree view of all registered data sources. It breaks down the
components of each data source and categorizes databases and corresponding database
objects by object type and underlying SQL code. This feature provides you with a view of the
contents of data sources in your enterprise in an easily navigated and cataloged interface.

E'EI Data Source Explarer &3 % S0L Project Explorer =0
iy BS Y

[= T=F Managed Data Sources (13) ~
[=]-T=F Daka Source Group (100
1=F Microsoft SQL Server (30
[=-T=F Qracle (73
| ROMLABORCLEI_1 (Cracls 8,1.7.4)
i ROMLABCRCLSI 2 (Oracle 2,2.0.1)
i sfvpelb0l .embarcadero,com (Cracle 10,2,0
Sl TORLABORCLE 2 (COracle 8.1,7.4)
Sl TORLABORCLY_1 (Crarle 2,2,0.8)
= TORLABSCORCL (MOVIES) (Cracle 10,2,0.1
ERTE]Catabase Ohjects
~# Check Constraints
geg Clusters
?é. Database Links
EQ Cirectaries
%2 Foreign Keys
fr Functions
&4 Groups
Indexes
[ch Java Classes
[Eb Java Resources
[§]:| Java Sources
Jobs
‘Ill Libr aries
£ Materialized View Logs
£ Materislized Wiews
COutlines w

Data Source Explorer sorts databases and database objects by category within DB Optimizer.

If data sources are particularly large or complex, or you are only developing specific objects, you
can apply database object filters on the view in Data Source Explorer.
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Overview of the User Interface

ADDING DATA SOURCES

In order to profile and tune statements, you need to register the data sources to be analyzed in
the environment by providing connection information and other details to DB Optimizer. Data
sources are registered and managed in Data Source Explorer. Each time you register a new data
source you need to specify its connection information and organize it in the View, as needed.
Once a data source has been registered, it remains stored in a catalog and does not need to be
registered again each time you open DB Optimizer. Furthermore, it can be used in multiple jobs,
archived, or otherwise “shared” with regards to the general functionality of the application.

Hy 21 % s0LProject Expl | — O
TR

=l [=F Managed Data Sources (5)
=I-l=F Daka Saurce Group (5)
+-=F Microsoft SOL Server (2)
=== Dracle (&)
=l ROMLABORCLEI_ (Cracls 5,1.7.4)
+ [_fj Database Obhjects
58 ROMLABORCLSI_Z (Oracls 9.2.0.1)
jFE sFvpclb0l  embarcadero,com (Oracls 10
| TORLABORCLE 2 (Oracle 5.1,7.4)
#-|{3 Database Objects
Efs| TORLABORCLE 3 (Oracle)
+ [__fj Database Objects
Sl TORLABORCL_1 (Oracle)
+ [_fj Database Obhjects

+

+

The Data Source Explorer view provides an organizational tree of registered data sources and the parameters associated with them.
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Overview of the User Interface

ADD A DATA SOURCE

Select Data Source Explorer and choose File > New > Data Source from the Menu bar.
The New Data Source Wizard appears. Follow the prompts to register the data source.

& New Data Source: New data source

Register a new data source

Choose the server byvpe and location For wour new data source,

Generate an unique name based on the alias or the host name

Data source name:

Select a server byvpe: Select a data source group:
r'tGeneric JDBC [= T=F Managed Data Sources
C'H4IEM DBZ For LW [=)-T=F Data Source Group
CHMicrosoft SOL Server [=-1=F Microsoft SOL Server
CHoracle [=1-1=F Microsoft SOL Server
Ct)5vbase ASE [=T=F vew
l=F Microsoft SQL Ser
1= Cracle

I=F Microsoft S0L Server

| #
|

|:| Create a new server bype-specific subgroup

Select & category: | Mo category 3 |

\
@

TIP:  You can categorize data sources in order to color code them in the Data Source
Explorer which makes the data source easier to find when you have a long list of data
sources. The data source will be decorated with the color associated with the category
selected for the data source. A set of preconfigured categories include Development,
Test, QA, and Production. You can also create custom categories. Existing data sources
can be categorized using the Data Source Properties page; right-click a disconnected
data source and select Properties.
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Overview of the User Interface

BROWSING DATA SOURCES

To analyze and tune statements on data sources within your enterprise, you must access the data
source objects within the application. It is important to view databases and underlying code in
an organized manner, especially when maintaining a large system. Data Source Explorer’s tree
structure can be used to view databases, tables, and other information about data sources.
Expand the nodes of each registered data source to view details about each data source. Data
Source Explorer is also used to launch profiling sessions, by enabling you to select the data
source that you want to execute, and then launching a profiling session from your selection.

HH Data Source Explore &3 % SCL Project Explare =0 @ *#Moview Tuning Job. b 23
i BB V|| fforade b HE TORLABSCC

| | L.é Overview FF' Analysis
== Managed Data Sources (5)

1= IBM DBZ For LUW (1) i, Overview 1 warning
[=+T=F Cracle (5
58 TORLABORCL10g_Z (Oracle 10.2.0.3.00
ER=* TORLABORCL11g_2 (O
#-L[3 Database Ohjects
= |Tl_l:| Profiling Repositary of Cut ‘u;|s'l,lal:|5'l,.ﬁ.ppllcatlnn Data'l,EmI:uar
=-H TORLABORCL11g 2 el -

e
[§ 2012-03-05 184308 — | 5 | DISELECT 110

e

e TORLABORCLSI_2 (Cracle 92,0, g Delets i [MseecTz

- i TORLABSCORCL (Oracls 10.2.0,

- Sl TORLABSQLOB_1 (500 Server 10
I=F 9L Server (1)

Tuning Statements

. ‘? Disconnect

ﬁ Cuplicate

= Sybase (1) Howe... Generated Cases
= Profiling Repositaries téh Refresh
li] ToRLABORCLIOG 2 5
=] M TORLABORCL11g 2 Fun Az *
=-H TORLABORCL11g_Z Profile As 4 b 1 Data Source
[[§ 2012-03-05 18:43:05 (33m)
|Tl_l:| TORLABORCLSI 2 Profile Configurations. ..
TNDE®
= 130 Into FLILL
Properties IMNDEY_COMEIME
- ALL_ROWS

The Data Source Explorer tree provides a list of databases, and enables you to launch Optimizer features, such as SQL Profiler, via
the context menu.

All objects listed in Data Source Explorer are sorted by data source name. Additionally, you can
view the underlying SQL code for an individual database object.
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Overview of the User Interface

To browse a data source

1 Expand a data source node, providing credentials if prompted.
2 Expand additional subnodes to drill down through object types and then individual objects.
3 Double-click the Code subnode for a particular object to view the code in SQL Editor.

Notice in the previous screenshot, there are Profiling Repositories listed in the Data Source
Explorer. For Oracle data sources only, you can save your profiling sessions to the Profiling
Repository for later examination. We'll discuss this more later in "Saving a Profiling Session
page 26.

‘on
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PROFILING A DATA SOURCE

NOTE: The SQL Profiler is not available in the “Basic” version of DB Optimizer.

SQL Profiler samples a data source and builds a statistical model of the load on the database.
Profiling is used to locate and diagnose problematic SQL code and event-based bottlenecks.
Profiler also enables you to investigate execution and wait time event details for individual
stored routines. Results are presented in the profiling editor, where you can identify problem
areas and view individual SQL statements, as needed.
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SQL Profiler analyzes and provides a statistical model of database load that identifies problematic code and event-based bottlenecks.

SQL Profiler is composed of the following diagnostic parts:

® The Load Graph provides a display of the overall load on the system. The bars represent
individual aspects of the data source.
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* The Top Activity section displays where load originates. Tabs available in this section differ
by platform, but typically available are the top SQL statements, the top events the database
spends time in, and the top activity sessions that may be causing issues in terms of query
time and response.

¢ The Profiling Details View displays detailed information for any item selected from Top
Activity. For example, examining a SQL statement from Top Activity displays the
identification parameters and the execution statistics of that specific statement selection.

STARTING A PROFILING SESSION

In order to access SQL Profiler, you need to run a profiling session on a data source registered in
Data Source Explorer.

To run a profiling session

In Data Source Explorer, right-click on a data source and select Profile As > Data Source. The
profiling session begins.

@ Progress % 3& |

mF'rl:-ﬁling torlabsgloo_2
[(eewms ]

Initalizing session...

The Progress view indicates that the profiling session has been initiated.

Once a profiling session launches, it runs until you stop it or it has run for its specified length of
time. You can stop a session by clicking the Stop icon on the right-hand side of the Profiling
progress bar.

When the profiling session is complete, the first two sections (Load Chart and Top Activity) will
be populated with information about the database load. You can then begin analyzing the data
and identifying problem areas.
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ANALYZING SESSION DATA

The SQL Profiler is composed of three essential diagnostic views that provide information about
load on a particular database in the system. These views enable you to identify bottlenecks and
view details about specific queries that execute and wait over the course of a profiling session.

The following describe the three components of SQL Profiler, in descending order of granularity:

e | oad Chart on page 21
® Top Activity on page 22

e Profiling Details on page 23

LOAD CHART

The Load Chart provides an overview of the load on the system, and is designed as a high level
entry point to reading session results. The colored bars represent individual aspects of the
database, and the graph can be used to discover bottlenecks.

Profile Session (‘I‘l £

] E«J CPLU B System /O B User 10 O Cluster B Application B Configuration B Commit B Metwark
| E ministrative B Concurrency O Scheduler @ Other

Maoaaas = - ]

o SR LR P R R R P W R @ L

The Load Chart displays the overall load of the database that you analyzed with Profiler.

[=3:3:1

Time is displayed on the X axis, and the Y axis shows the average number of sessions waiting or
executing. Each support platform type has a specific set of wait event times. For example,
Sybase platforms will display CPU, Lock, Memory, I/0, Network, and Other categories. Use the
chart legend to understand the graph. It displays a color and code scheme for executing and
waiting session categories in the upper right-hand corner of the chart.
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TOP ACTIVITY

Below the Load Graph, the Top Activity section displays where the load originates and outlines
items such as the top SQL statements, top events, and the top activity sessions on the database.
It is composed of a series of DBMS platform-specific tabs that provide detailed statistics on
individual SQL statements and sessions that are waiting or executing over the length of the
profiling session.

m . . LY e eV @ eV g e e
@ P @ P ¥ o F o ¢ oV ¢ e

4
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-§.§ Ohe e = osaL {P} Events -.;1 Sessin:-ns-g (@8 Blockers &0 Clb_iectl."OE

[

User Marme | Prograrm | =D Serial® Active () kdachine

The Top Activity section displays a more detailed view of the Load Graph. It identifies top statements, events, and sessions that are
waiting or executing over the length of the profiling session.

While available tabs differ by platform, the most common are:

e The Overview tab provides summary information about SQL statements and events and
their activity levels, and sessions, their system process IDs and their activity level. You can
reorder the rows in any of the three sections of this tab. For example, clicking the Event
column in the Events section changes the alphabetical order to ascending or descending.

e The SQL tab provides information about SQL statements and procedures. This includes all
INSERT, SELECT, DELETE, and UPDATE statements that are executing or waiting to execute
over the length of the profiling session.

e The Events tab displays information about wait events, and should be used to tune at the
application or database configuration level. For example, if the top events are locks, then
application logic needs to be examined. If the top events are related to database
configuration, then the database setup should be investigated.

e The Sessions tab displays information about sessions, and can be used to discover sessions
that are very active or bottlenecked.

e The Object I/O tab provides information about I/O when profiling an Oracle data source.

e The Procedures tab provides information about the procedures running in the session when
profiling a SQL Server or Sybase data source.
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PROFILING DETAILS
When you select any item from Top Activity, details are displayed on the Profiling Details view.

TIP:  You may have to select Windows > Show View > Profiling Details to display the
Profiling Details view.

The tabs that compose the Profiling Details view are dependent on the nature of the object
selected in Top Activity, in order to reflect that item’s specific information. The tabs are also
dependent on the data source platform. For example, the Object I/O tab is available only for
the Oracle platform whereas the Procedures tab is available only for the SQL Server, Sybase,
and Oracle platforms.

Profile Session @

] Ed CPLU B System 10 BUser V0 O Cluster B Application B Configuration B Commit B Metwork
I £ ministrative B Concurrency 0 Scheduler @ Other

e Ses5s5i0

4 F

§§ Dvewlew g SQL {9 E\.-'ents mSessmns ﬁ Blockers | l‘;'»"1'_'1I::ilt:unau:tl.-rl:j

User Mame | Frograrm | SO Serialf Active (246 kdachine o
| JDBC Thin Client - 48048 B 9348 rowcbulgariug2 T
|| SYSTEM IDBC Thin Client 102 A EEEER rowvcbulgariul2 |
|| S¥ETEM IDBC Thin Client 136 743 [ 9335 rowchulgariul2 - |
@ Profiling Details 52 = 0

Session: 147, 48098 (SYSTEM/IDBC Thin Client)

Statement Executiu:uns .ﬂwg Elapsed l{seu:]l B Actwlt}f {?/]l 5
\f SELECT CCILI[N.ITR‘?r MAME C...ERE SH.SALES.TIM 52 490,385 _1[IEI [IEI -:

Profiling Details displays detailed parameter information on a statement, event, or session that was selected in Top Activity. The data
displayed also varies by database platform.

Depending on the data source platform you have specified, the tabs that appear in the view will
be different, in order to accommodate the parameter specifics of the statement you have
selected.
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Depending on the top activity selected and the profiled platform types, some tabs may not be
available.

NOTE: When right-clicking on a SQL statement in the Top Activity section in the SQL Profiler,
if the SQL statement is run by a different user than the user who is running DB
Optimizer, then the User Mismatch dialog appears, with an example of the following
message: This query was executed by [SOE] and you are currently connected as
[system]. We recommend you reconnect as [SOE] to tune the SQL. Would you like
to continue anyway? This message indicates that the statement is being tuned by a
user other than the user who originally ran the query, and tables may be missing based
on the different schemas. Click OK to run the query, or click Cancel and run the tuning
job under the original user.

VIEW SESSION DETAILS

1 In the Profile Session area of the SQL Profiler, in the Sessions column click anywhere in the
row of an application that ran during the profiling session.

2 In the Profiling Details area, click the Sessions tab.

Details of the session are displayed.

-E.-E. Session Details %LSQL{P! Events_? E_Bluckers .5?} F'n:n:eduresg

Database Server Connection Client Tool Application
0 94 Application JDBC Thin Client S0OLID bbigh3Swdpp:d
Serial 50915 05 User Catalinb 0L Operation Code 3 |
User Marme SYSTER 0% Process [0 1234 Last Call Elapsed Tirme I]III:I]I]:I][I.[;
Process D5 PID 6316 Hosthame rowcbulgariul2 bodule IDEC Thin Client ||
|| Logged On Time 2012-11-0107:12:58.0 Terrminal unknowr Action .
Logged On For 00:08:14.93 ClientID 0L Trace DISABLED
Connection Type DEDICATED Client Info

Session Type USER

Resource Consumer Group

VIEw SQL

1 In the Profile Session area of the SQL Profiler, click anywhere in the row of an application
that ran during the profiling session.

2 In the Profiling Details area, click the SQL Text or SQL tab.
The associated SQL test is displayed.
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O SOL Text

SELECT /*+ rule */
bucket,
endpoint,
col#,
epvalue

FROM histgrms

WHERE
obi¥ = :1 AND
intcol® = :2 BND
rowd = :3

CRDER BY bucket

4

TIP:  From the SQL tab you can easily tune a statement by right-clicking a statement on the

SQL tab to initiate the tuner, which then opens with the selected statement in the Ad
hoc SQL tab of the Tuner Input.
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SAVING A PROFILING SESSION

A profiling session can be saved to a file with a . oar suffix that contains the name of the data
source. When profiling Oracle data sources you can alternatively save the session data to the
Profiling Repository. This enables you to open the file at a later time for analysis.

SAVE A PROFILING SESSION AS A .OAR FILE

Select the profiling session and then choose File > Save As. Specify the project location
you want to save the file in and modify the file name, as needed. Click OK. The project is
added to SQL Project Explorer.

Save As

Save file to another location,

Enter or seleck the parent folder:

| SQLProject

% s0LPraject

File name: | sFvprlb0l.embarcadero. com.oar |

@:\J [ Ok H Cancel ]

Once you have saved a profiling session, it appears in the SQL Project Explorer under the name
you saved it as. It can be opened again by double-clicking the project name.

SAVE A PROFILING SESSION IN THE PROFILING REPOSITORY

You can also have the session saved automatically as a Profiling Repository file in an Oracle data
source. This allows you to profile your data source for a longer period of time, for days or even
weeks.

Right-click the data source you want to profile and select Profile As > Profile
Configurations.

In the Profile Configurations dialog, select Save to data source and then select the data
source where you want to save the profile sessions.

26 DB OPTIMIZER XE4/3.7 QUICK START GUIDE



Profiling a Data Source

The saved session file, named using the date and time when the profiling session was stopped,
can be viewed from the Data Source Explorer and thus available to share with other DB
Optimizer users.

IMPORTING STATEMENTS TO SQL TUNER

SQL Profiler enables you to submit one or more statements into SQL Tuner. This enables you to
take advantage of Tuner’s hint-based and transformation-based suggestions if you want to tune
a problem statement that you detected over the course of a profiling session.

2 Profiling Details -
Sess
E=Session Details| & SQL |2 Events
Statement Ex...s

© LUPDATE CATA.... > 10000%:B1 209
~+'select * from cata Organize By v 1l

© UPDATE CATA...4

& UPDATE CATA...., ©opY

select * from cata = Eyplain Plan

W INSERT INTO CA..
5 Non-SQL Activity

- 1 P S -

# Tune

Context menu commands in SQL Profiler enable you to import statements to a tuning job directly from the Profiler interface.

Import a statement from SQL Profiler into SQL Tuner

Select one or more statements in Profiler, right-click and select Tune from the context
menu. SQL Tuner opens and contains the selected statements in a new tuning job. You can
now proceed to tune the problematic statements.
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TUNING SQL STATEMENTS

SQL Tuner provides an easy and optimal way to discover efficient paths for queries that may not
be performing as quickly or as efficiently as they could be. Tuner enables the optimization of

poorly-performing SQL code through the detection and modification of execution paths used in
data retrieval. This is primarily performed through hint injection, and index and statistics analysis.
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Tuner analyzes specified SQL statements and then supplies execution path directives. This enables you to select alternate paths for
queries, thus optimizing system performance based on analysis.

For example, if tuning is selecting from two tables (A and B), it will enable the joining of A to B,
or B to A as well as the join form. Additionally, different joining methods such as nested loops or
hash joins can be used and will be tested, as appropriate. Tuning will select alternate paths, and
enable you to change the original path to one of the alternates. Execution paths slower than the
original path are eliminated, which enables you to select the quickest of the returned selections
and improve query times, overall.

This enables the DBA to correctly optimize queries in the cases where the native optimizer

failed.
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CREATING A NEW TUNING JOB

New tuning jobs are created from scratch where you can specify the statements to be tuned
from a variety of sources, or statements can be directly imported from existing profiling sessions

on data sources currently registered in the environment.

|5 mattun ([l proffetorLaBsconct. |31 *unbied Tuning Job B2 M =B
b Iy Microsoft SOL Server # “__L] TORLABSQLO0_L (3.0.2039.0)
= Overview ‘ F‘\' Analysis I
EE Dverview =@
T Mew S0L Text
Tuning State [FlGererate case  [JPerformdetal  [JExecuie each generated case | 1 [ Extract from Database Object
[Fel Tmpart From File (Workspace)
Staterent : (56 Trnpeort From File (System)

Mame ' Catalag Sehams Texk Tables Wiz ElS e

Tuning jobs are defined in SQL Tuner by specifying the data source and corresponding statements to be tuned and then executing

the tuning job process.
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CREATE A NEW TUNING JOB

If you determined from a profiling session that a specific SQL statement should be tuned, in
the Profile Session, right-click the statement and select Tune as follows:

£E Overview 55" S0L {B‘ Events | &7 Sessions &0 Chject T/0

e

SQL Statements Events
Skatemnent [ Event DE
*% INSERT INTO ... 'dml_locks' ] 0N CPU [
*@ IMNSERT INTO L. Free',1,'R I dhb File sequential read |
seleck* . MTR_DaTa_ 1 I null event |
SELECT "' F...PE —

Crganize By r

£

Copy

@ Profiling Details 53 <22 Explain Flan

Tune
SQL: SELECT "X" FROM {ERE OBJECT_NAME =:1

D% col Test | @l SOLD e oo _essions | CBY Children Detail

OR

Select File > New > Tuning Job, or click the New Tuning Job icon on the Toolbar. SQL
Tuner opens and you can proceed to set up the parameters of the new job.

Once you have defined the input of the tuning job, you can save the file with a . tun suffix
via the Save As... command. The job is added to the SQL Project Explorer and can be re-
opened and re-run at any time once it is saved to the system.

ADDING SQL STATEMENTS TO A TUNING JOB

Once you have created a name for the tuning job and indicated its source, you can add SQL
statements that you want the job to tune. Statements are added to a job via the options
available in the SQL list on the Overview tab. All standard DML statements (SELECT, INSERT,
DELETE, UPDATE) are viable for the tuning procedure. On SQL Server 2008 and higher, MERGE
statements can also be tuned.
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Statements are added to a tuning job via the Overview tab.
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There are four or five different ways to add SQL statements to a job, as reflected by the options
available in the SQL list as shown previously:

¢ New SQL Text: Copy/paste SQL statements to the New SQL Text window or write queries
by hand. You can also paste a statement directly into the Overview statement grid by
copying the statement and then right-clicking anywhere on that grid and selecting Paste.

e Extract from Database Object: Drag and drop database objects from the Data Source
Explorer to the Statements grid on the Overview tab.

¢ Import from File (Workspace) and Import from File (System): Browse the workspace or
file system and select SQL files.

¢ Scan Oracle SGA: For the Oracle platform only, you can also scan the System Global Area
(SGA) for statements to tune.

ADD NEw SQL TEXT

From the SQL list, select New SQL Text and manually type an SQL statement in the window.
Alternatively, copy/paste the statement from another source.

45 New SOL Text e

Add Tuning Statement S u L
Add a SQL statement. t}

SELECT -
Firs=st,
La=t
FROM
Employee
WHERE
Gender = "EF"

Apply

T A
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ADD A DATABASE OBJECT

From the SQL list, select Extract from Database Object. The Data Source Objects Selection
dialog appears. Type an object name prefix or pattern in the field provided and choose a
statement from the window as it populates to match what you typed.

% Data Source Objects Selection i_,@
Enter object name prefix or patkern (¥ = any character, * = any skring): -
E |
Matching objects:

& COUNT_TIME_INTERVAL {Package) - SYSTEM ~

~ZDEMS_REPCAT AUTH (Package) - SYSTEM
% DRS (Package)

=& [RGS (Package) - SYSTEM
=4 [RGS2 (Package) - SYSTEM
% DRGSS (Package)

=S EMP_ACTIONS (Package) - SYSTEM

Al CRAN MENT MATA SMaele—mst

[ %

Configure data source indexing.. .

® I Ok, l [ Cancel

TIP:  You can also drag an object, such as a Packages, Package Bodies, Views, and
Functions, from the Data Source Explorer to the grid on the Overview tab.

NOTE: In order to drag a database object on the Overview tab, the database object in the
Data Source Explorer must be in the same database that displays in the bread crumbs
at the top of the Tuning window.

ADD A SAVED SQL FILE

From the SQL list, select Import from File (Workspace) or Import from File (File System),
depending on where the file you want to add is stored. Select a file from the dialog that appears
and it will be added to the tuning job.
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ADD ACTIVE SQL IN SGA

From the SQL list, select Scan Oracle SGA. Specify any filters as required and then click Next.
From the list of SQL statements retrieved from the SGA, select those you want to optimize, and
then click Finish. The selected statements are copied to the tuning job.

& Scan 5GA |._|®
SGA filters £
Specify the filkering criteria for ackive SQL in the SGA, DJ

Filker Criteria

Maxirum retrieved queries:ﬂ'| v |

Sort by: |CPU Time v |

advanced Filters

User: | A4 |

Parsing Schema;

Module: | w |
Bckion: | e |
Service:

RUNNING A TUNING JOB

After you add SQL statements to the job, click the Overview tab. Once you choose your tuning
options and click the Run Job icon, the DML is parsed from the statements and added to the
Generated Cases area. The Generated Cases are alternative execution paths or explain paths
that could be better or worse than the default path the database uses. When these cases are
executed you can use the execution statistics to determine which case would optimize
performance.
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Each extracted statement is listed by Name and Text. Additionally, each statement has a Cost,
Elapsed Time, and Other Execution Statistics value that provide information on how effectively
each case executes on the specified data source. These parameters let you compare the
efficiency of the original statements to the cases generated by the tuning process when it is
executed.

TIP:  You can double-click a generated case to view or edit the SQL source of the statement.
Tuning Status Indicator Column Set Run/Cancel Job

Enable Execution Expand/Collapse Controls
Check Box ) Control
Schema and Catalog Pane Size Control
Selectors Increase/Decrease
B overview |/B Analys /

s B O

brning detected
Tuning [Jeenerate Cages [ Perform detai analysfs Exafute each pererated case w )
) Sfatement ) : ] Time ] ) An
o Schema Text Tables Visws Elapsed (s) improved () Cases Incha:

T MssEcTe MOVIES v | select from BROKER, 6.32 6.32 0
T Blseect .00 .00 10
< 2
Generated Cases P Generated Case Filter Control —pgm 2
Expand/Collapse-Gontrol
}Q@.‘al‘ements and Cases ¥ Cost #Exgcutl...istics ] Lid Qther
| T Text | Value | ElapsedTime (s) | Physical Reads | Lo
B E select from BROKER, CLIENT _TRANSACTION, 34014.0 £.32 2
el .sfarmatian 274.0 0.03 i
fel £ SELECT 1 select from cient_transaction, dient, 4.0 0.00 0
e USE_HASH 14.0 0,00 o
el ORDERED 8.0 0.00 i)
el NG_LISE_ML 16,0 0.00 1]
= LEADING4 _ Extracted SQL 4 , 0.00 0
s \Eanmgs  Transformation Case Statements 0.0 ol o
eEl LEADING2 Hint-Based 7.0 0.01 o
e LEADING 1 / Cases 4.0 0.00 0
HTJ INDEX_FFS 9.0 0.0 i ]
e ELLL £4.0 0.00 o
g5 - FIRST_ROWS 40 0.00 o
< >

The Generated Cases table enables you to measure the various load costs of the original tuning statements and generated cases for
each, which suggest alternative query paths to optimizing your data source.

The Tuning Status Indicator provides the status of each statement or case, and indicates if they
are ready for execution. In some cases, SQL code may need to be corrected or bind variables
may need to be set prior to executing statements. When you try to tune a statement containing
a bind variable you are now warned that either the type is not set or the value is not set.
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Use the check boxes to select which statements and cases you want to run and then click the
Run icon in the upper right-hand corner of the screen. The Execute each generated case field
enables you to execute each selected statement or case.

Use the Schema and Catalog Selectors to select a schema and catalog for the tuning job. The
catalog selector is available only for SQL Server and Sybase data sources. By specifying the
schema and catalog, the tuner can use the paths of the schema and catalog selected to find the
tables queried in the job rather that use the paths of the schema and catalog used to connect to
the data source. If you change the schema or catalog used in a tuning statement you will need to
refresh the tuning statements in order for new cases to be generated, which take into
consideration the schema used. Right-click a tuning statement and select Refresh Tuning
Statements.

Once you have executed a tuning job, the Generated Cases tab will reflect SQL Tuner’s analysis
of the specified statements. Once these have been analyzed, you can proceed to modifying the
Tuner results and applying specified cases on the data source to optimize its performance.

RUN A TUNING JOB

1 Once you have a SQL statement that is a tuning candidate, navigate to the Overview tab.

2 Inthe Tuning Statements area, select the checkbox next to the Statement name that you
want to analyze and then:

To analyze the SQL statements, click Generate cases.

To perform the analysis that populates the Analysis tab now, click Perform detail analysis.
Otherwise, this analysis is performed when you click the Analysis tab.

To have the system generate execution statistics, click Execute each generated case and
then select the number of times the system should execute each generated case. Multiple
executions can verify that the case results are not skewed by caching. For example, the first
time a query is run, data might be read off of disk, which is slow, and the second time the
data might be in cache and run faster. Thus, one case might seem faster than another but it
could be just benefiting from the effects of caching. Generally, you only need to execute the
cases once, but it may be beneficial to execute the cases multiple times to see if the
response times and statistics stay the same.

3 Then click the Run Job icon at the top right-hand side of the window. The tuning job runs,
analyzing each statement and case, and providing values in the appropriate columns.

ANALYZING TUNER RESULTS ON THE OVERVIEW TAB

When you have executed a tuning job, the Generated Cases area of the Overview tab reflects
Tuner’s analysis of the specified statements and cases. The Generated cases create alternative
execution or explain paths that could be more or less efficient than the default path the
databases uses. Executing these cases provides the statistics necessary to optimize
performance.
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Once a tuning job has executed, use the Cost and Execution Statistics value columns to
determine the fastest execution path for each statement. The Cost column shows the
performance cost of an execution path as determined by the database. The Execution Statistics
are the actual results of running the SQL statement using the generated case. This is where DB
Optimizer can help you find where the database default path is actually not the optimal path.
The Elapsed Time(s) and Results columns can more accurately show the most efficient
execution path.

In the Cost and Execution Statistics columns, the values of the original statement are
considered to be the baseline values. A Cost column can be expanded to provide a graphical
representation of the values for statements and cases. Similarly, the Execution Statistics column
can also be expanded to display a graphical representation of values as well. The bar length and
colors are intended as an aid in comparing values, particularly among cases.

0.78

1.243 I
0,600 M

0,499

Dl?g? ——

0.828 L

Case query times based on the original statement can be represented as colored bars on the Generated Cases area of the Overview
tab to help you determine the fastest execution path for the given selections.

The baseline value of the original statement spans half the width of the column, in terms of bar
length. For cases of the original statement, if one or more cases show a degradation value, the
largest value will span the width of the column. Bar lengths for all other cases will then be
displayed in comparison length to the highest degradation value.

The cost and execution results are color-coded as follows:

e Light blue: These cases are within the degradation and improvement threshold. Applying
these changes may marginally improve or degrade the efficiency of the SQL statement.

o : These cases have values less than the improvement threshold. There is a high
probability that changing the SQL statement with this alternative execution path will
improve efficiency.

¢ Red: These cases have values higher than the improvement threshold. Implementing these
changes will degrade the efficiency of the SQL statement.

DETERMINE THE BEST CASES FOR STATEMENT EXECUTION PATH TIME

Once the tuning job has executed, view the Generated Cases area of the Overview tab
and determine the best possible case in terms of the Execution Statistics column values.
This will indicate the most optimized query path for a given statement. Once you have
determined the best case, you can execute that case on the specified data source and alter
the database code to run the statement as that case on the native environment.

If you don't find an acceptably fast path, go to the Analysis tab. The Analysis tab can
identify missing indexes and by examining the diagram you may be able to determine if
there is something wrong with the SQL or schema.
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FINDING MISSING INDEXES AND SQL PROBLEMS

The tuner performs the index and SQL analysis as part of the tuner run job performed on the
Overview tab if Perform Detail Analysis is selected. Otherwise, the analysis is performed when
you click the Analysis tab.

¥ o Oracle ¥ 5 sfvpclbil embarcadero,comi( (10.2.0,1)

= -
E sOL Analysis : Select statement of interest: |PDATE 1 :] e B | @
UPDATE &
_ . SIES0Y
NOVIERENTAL XXX 3 RENTALITEM (TTH)
SET TOTALCHARGE = [SELE -
FROR rd \
~ slSirs
s P
" BIEGT e -"~'-'ﬁ1-'\\
[ 3 moviERenTAL (on) | BB MoviECoey (cor)
WHEF Visual SQL Tuning Diagram Eargne
B30T
| -
4 *
- ~Create Index Button
|= Index Analysts | [E] Table Statistics| £ Column Statistics And Histograms | [} Oudines
Collect and creats indexes i 5
Index: Name Table Owner Table Name i
f D"'I SECATEGORY _PK MICIES MCVIECATEGDRY B TE 3
" [CmoviECory_F ACIVIE MCATTECOPY AL 4
& CIMOVIETITLE_P MCVIES MCAIETTTLE MOWIEID  f
& [CIRENTALITEM_P¥ MCVIES RENTALITEM RENTALIL|»

DB Optimizer can parse an SQL query and analyze the indexes and constraints on the tables in
the query and display the query in graphical format on the Visual SQL Tuning (VST) diagram. The
VST diagram can be displayed in either Summary Mode or Detail Mode. The VST diagram helps
developers, designers, and DBAs see flaws in the schema design such as Cartesians joins,
implied Cartesians joins and many-to-many relationships. The VST diagram also helps the user
to more quickly understand the components of an SQL query, thus accelerating trouble-
shooting and analysis.

This section is comprised of the following topics:

¢ Finding Missing Indexes on page 38
® Exploring the VST Diagram on page 39

¢ Finding Problematic SQL or Schema on page 46
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FINDING MISSING INDEXES

Missing indexes are color-coded orange in the Collect and create indexes area of the
Overview tab. Creating a missing index can improve the execution path of the SQL statement
being analyzed.

TIP: Indexes that are used are color-coded green. Indexes that exist in the table but are not

used in this execution path are color-coded grey. Indexes that are usable but not used
by the current execution path are color-coded blue.

[El ndex Anakysis | [ Table Statistics | 2 Column Statistics And Histograms | 5] Oudines

Callect and creste indexes

ol
- Index Miame Table Civanesr Table bame Column Mame
5 OIo%_MOVIERENTAL O Mo e =
J0 Oiox_MOVIERENTAL 1 o el |
@ [lioe_CusTOMER Ik MOVIES CUSTOMER CUSTOMERID, LASTNAME ::
B [CMOVIERENTAL Pt MOVIES MOVIEREMTA RENTALID
< S
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EXPLORING THE VST DIAGRAM

Select stakement of interest:

%% 27 ol |

3 ¢ u

| I3 RENTALITEM (R} |

G NOT IM (2

| Bl MOVIERENTAL (MR) |

| (3 cusTOMER (C5)| S SUBQUERY (1)

4 b

Legend
Display/Hide Diagram Legend
Display/Hide Explain Plan
Display/Hide Ratio Counts
Display Detail Mode or Summary Mode
Zoom In

Zoom Out
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DISPLAYING OR HIDING THE DIAGRAM LEGEND
Click the Diagram Legend toggle [EZ]] to view the legend and then click it again to hide it.

All the icons used in the VST diagram are identified in the Diagram Legend.

Diagram Legend A
Table
View

Materialized Yiew

E R e m

Sub-guety

|

Zommon Table Expression

]

Colurmn

Index

v [

Primary kKew
U Unique Key
[d Filkered object

Za—== Many ko Many (M:N)
—== Parent ko Child (1:M)
Unique (1:1)
4= OUTER J0IN

EXISTS J IN w
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DISPLAYING OR HIDING THE EXPLAIN PLAN
NOTE: The Explain Plan is available only for the Oracle 10g and 11g platforms.

Hover the mouse over the VST diagram to see the Explain Plan icon [¥% and then click it to
view the Explain Plan Overlay. Click the Explain Plan icon again to hide the overlay.

The additional nodes shown in the Explain Plan overlay provide details on the flow of the
query plan, with operations (such as nested loops, sorts, and joins) showing connecting

tables and other operations.
7ML

{3 RENTALITEM (R1) |
»*

200 EI
|3 moviECoRY (mC) |

B2

=]
[ cusTomER (<3)| | B MOVIERENTAL |

Hover the mouse over the objects or relationships in the overlay to view additional details.

DISPLAYING OR HIDING TABLE COUNTS AND RATIOS
To view or hide table counts, two table join sizes and filtered result set ratios, click the

Ratios and Counts icon [ '] ]

3 K u
1 10000
& SUBQUERY (1) | (3 RENTALITEM (RI)
-\j{.-' 100%%
|
15;31 10000 10000
Sona +s 0
| = MOVIERENTAL (MR} | S MOT IN (2)
E000n

[ |

| (3 CUSTOMER (C5)
100%:
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Green numbers at top left of table represent the total number of rows in that table. In the above
example, the MOVIERENTAL (MR) table has 5000 rows.

Blue percentage at the bottom right of the table represent the percentage of rows in that table
that meet the selection criteria. In the above example, 100 percent of the rows in the
RENTALITEM (RI) table have met the selection criteria.

The numbers on the table joins indicate the total number of rows that meet the selection criteria
for both tables.

You can also view the SQL Query that created a relationship by hovering over the relationship. If
the tooltip contents is larger than the size of the tooltip rectangle, you can hover the mouse on
top of the tooltip for a second, then it will turn into a dialog you can re-size, scroll in, and select
text from to copy into the Clipboard.

1 10000
5000 [ [ RENTALITEM (RI)
| = MoVIERENTAL | /,I %%
e 100
1591 Cardinality: Master-Detail
\ % Joined Row Count: 10000
S0on . .
¥ Relat 3
[ E MovIERENTAL (M1 0 00
ri.RENTALID = mr,RENTALID
Y Columns:

S'JrIIJ MOVIERENTAL.RENTALID

. RENTALITEM.REMTALID

| Ij CIUSTOMER. (5! SOL Count Statement:

T SELECT COUNT (*)
FROM
MOVIES.MOVIERENTAL MR,
MOVIES.RENTALITEM RI
WHERE ri.RENTALID = mr.RENTALID

DISPLAYING OR HIDING TABLE COLUMNS AND INDEXES

Click the Detail/Summary switch to display or hide details of the table display, including
table columns and indexes.

Only fields that are used in the WHERE clause are displayed in detail mode. For information
on interpreting the icons used in Detail mode, activate the Diagram Legend.

TIP:  You can also switch between Summary Mode and Detail Mode for a specific table or
view by double-clicking the object name.

NOTE: You can move tables in the diagram by clicking and dragging them to the desired
location. The position of the connecting lines is automatically adjusted.
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VIEWING ALL FIELDS IN A TABLE
Hover the mouse over the table name to view all fields in the table in a pop-up window.

The illustration below shows the pop-up window that appears when hovering over the table.

REMTALITEM (RI}

[3E ITEMMUMBER : NUMBER
2= MOVIECORYID: NUMBER
[3E RENTALID: NUMBER

REMTALITEM_FK1
REMTALITEM_FKZ
“B REMTALITEM_PK

]
MOVIERENTAL (MR &g MOT TN (23
£= CUSTOMERID: MUMBER [3E COPYCONDITION: CHAR
DUEDATE: DATE [5E COPYFORMAT: CHAR,

RENTALID: MUMEER.
TOTALCHARGE: MUMEBER.

ID%_MOYIERENTAL_O
MOVWIEREMTAL_FK1
MOWIERENTAL_FKZ
MOWIEREMTAL_IE1
MOWIEREMTAL_IEZ
¥ MOYIERENTAL_PE

¥ X
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VIEWING OBJECT SQL

Hover the mouse over the table name, field, or index displays the SQL required to create

that object.

/

MOVIERENTAL
CREATE TABLE MOVIES.MOVIERENTAL

RENTALID MUMBER.(10,0) MOT MULL,
RENTALDATE DATE

MOT MULL,

HAR

EEF.

T T T T T

ID%_MOVIERENTAL_O
MOVWIERENTAL_FK1
MOWIERENTAL_FKZ
MOWIEREMTAL_IE1
MOWIEREMTAL_IEZ _
¥ MOYIERENTAL_PK iR

MOVIECOPY _FE
MOYIECORY IE1
MOWIECORY _IEZ
B MOVIECOPY_PK

W

VIEWING RELATIONSHIPS
Hover over the join between two tables displays the relationship between the two tables.

REMTALITEM (RI)

[5E ITEMNUMEER: NUMEER:
£= MOYIECOPYID: NUMEBER
[5E RENTALID: NUMBER:

REMTALITEM_FK1
REMTALITEM _FKz2
“B REMTALITEM_PK

)

Cardinality: Master-Detail

Relations:

MOYIEREMTAL (MR

DUEDATE: DATE

2= CUSTOMERID: NUMBER

REMNTALID: MUMBER.
== TOTALZHARGE: MUMEER.

Columns:

ri. RENTALID = mr.REMTALID

IC%_MOVIERENTAL _O

EXPANDING VIEWS IN THE VST DIAGRAM
For example, the following is the default layout from query join table CLIENT (c) to view

TRANSACTIONS (t).

44
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Right click on the view, and choose Expand View
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Now we can see the objects in the view.
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W
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FINDING PROBLEMATIC SQL OR SCHEMA
In the Visual SQL Tuning (VST) diagram, a well-formed query would resemble the following:

| B CLIENT_TRANSACTION (ct) |

CLIEMT {c)

One-to-Many

| B INVESTMENT ()
Y

| INVESTMENT_TYPE (it}

Problems such as Cartesian joins, implied Cartesian joins, and many-to-many relationships are
clearly represented in the VST.

Cartesian Join

| E& CLIENT TRANSACTION |

BR.OKER

| & oFFICE_LOCATION | Many-to-Many

Joins are represented with connecting lines between nodes. The following describes when a
particular type of connecting line is used and the default positioning of the line.

Connecting Lines

When used

One-to-One Join relationships are graphed horizontally using blue lines. One-to-one joins
exist when two tables are joined on their primary key.

One-to-Many Join relationships are graphed with the many table above the one table.

Cartesian Join shows the table highlighted in red with no connectors to indicate that it is
joined in via a Cartesian join. The query is missing join criteria. A Cartesian join problem could
be resolved by implementing a rewrite suggestion shown in the Generated Cases area of the
Overview tab.

Many-to-Many Join relationships are connected by a red line and the relative location is not
restricted. If master detail information is missing then the VST diagram will have many-to-
many connectors. The optimizer can more consistently optimize a well-formed query, so the
query will run faster.
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IMPLEMENTING RECOMMENDATIONS ON THE INDEX ANALYSIS TAB

Once you have added tuning candidates to a tuning job, DB Optimizer can analyze the
effectiveness of the indexes in the database and recommend the creation of new indexes where
the new indexes can increase performance.

In the Collect and create indexes table, an index that DB Optimizer recommends that you
create is marked in orange and has a create index icon next to its checkbox.

Index Analysis Table Statistics | E£ Column Statistics And Histograms Cutlines

Collect and create indexes

W | g0

Inde:x Mamne Table Cwner Table Marne Calurnn Marmne Index
£E| [# 10X _CLIENT_TRANSACTION_O  SYSTEM CLIEMT_TRAMSACTION  TRAMSACTION_STATUS Marmal
® [ CLIENT_MULTI SYSTEM CLIEMT CLIEMT_FIRST.. NT_LAST_MAME  Mormal
# [ CLENT_BROKER VATEM CLIEMT BROKER_ID Marmal
# [ CLENT_INCOME SVATEM CLIEMT CLIENT _HOUSEROLD _IMCOME Mormal [
% [JcLEnT PE SYSTEM CLIEMT CLIEMT_ID Unique
¥ O CLIENT_TRANSACTION_BROKER SYATEM CLIEMT_TRAMSACTION  BROKER_ID Marmnal
{w C 1 FMT TRAMSACTTON O TFRT SWSTEM CLTFMT TRAKMSACTTON L TFMT T | Marmal 5 b

ACCEPT THE SUGGESTION AND AUTOMATICALLY GENERATE AN INDEX
1 For any recommended index, click the checkbox to the left of the index you want to create.

For a selected index you can modify the Index type by clicking in the Index Type column
and then selecting a type from the list: Normal, Bitmap, Reverse Key, Reverse Key
Unique, or Unique.

Index Anahysis | [E5) Table Statistics | SE Column Statistics And Histograms | [£2] Outlines

Collect and create indexes i ﬁEI.J
Index: Mame Table Owner Table Name Cobi# Creat
O [ 10%_MOVIERENTAL_D MOVIES MOVIERENT Al TOTALCHARC Index
« [Ocustomer_pk MOVIES CUSTOMER CUSTOMERIC
« [OmoviEcory Pk MOVIES MOVIECOPY MOVIECORYII
o [CIRENTALITEM FK1 MOVIES RENTALITEM RENTALID
@ [Joustomer _IE1 MCOYIES CUSTOMER LASTMAME
& [Clrhsthmre w7 FACNIFES IISTNMER PHIMRIF 'U'
< >
2 Click the Create Index button.

The Index Analysis dialog appears.

To view the index SQL in an editor for later implementation, click the statement and then
click Open in a SQL editor.

To run the index SQL and create the index on the selected database, click Execute.
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SQL CODE ASSIST AND EXECUTION

SQL Code Assist is an interface component that enables the development and formatting of
SQL code for the purposes of creating and modifying database objects. It provides a front-end
application for the delivery of code through its object code extraction capabilities.

Code Assist provides a number of key features that assist in the coding process, ensuring
greater accuracy in coding, faster development cycles, and a general increase in efficiency
overall.

i‘/'l Benison.sqgl 2%

CREATE TRBLE dbo.benson L
{

job CHAR (8) MOT HULL,

=al WHOMERIC (38, 0) HOT NULL,

loc NHUMERIC (38, 0) NOT NULL,

COHNSTRAINT pjob PRIMRRY EEY CLUSTERED (job)

go
IF OBJECT ID('dbo.benscn') IS NOT NULL k.
PRINT '<<«< CREATED TABLE dbo.benson >33
6 FROHT. s AR T D CREAT TS TR cdho henaon, e
=
b

SQL Editor provides key features to ensure an increase in code accuracy and overall development efficiency.

The following key features are provided with SQL Code Assist:

¢ Code Extraction on page 49

e Code Highlighting on page 50

® Automatic Error Detection on page 50

¢ Code Complete on page 52

e Hyperlinks on page 52
® Code Formatting on page 53

¢ Code Folding on page 54
e Code Quality Checks on page 54

In order to access SQL Editor, you need to create a new file or edit existing code from Data
Source Explorer.
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Additionally, SQL Project Explorer provides a tree structure for all files created in DB Optimizer.
You can access files from here by double-clicking the file name you want to open as well.

3 Data Source Explorer E_P,} SQL Project Explorer 53 =

1
I
=

= {3 5QL Project 1
+ * Connections
= |£'l' Creation Scripts
=i Tables
% dbo.benson (Benson.sql) [datoth15]
+ 5|:'|" General QL
l' Large Scripts
+ _b,._" Unknown Fles
[# Benson.sql
% Fie,sal
[*9% test.sql

3 |

SQL Project Explorer provides a tree of all files developed and saved in DB Optimizer.

To create a new file
Choose File > New > SQL File.

A blank instance of SQL Editor appears in the Workbench. If you save this file, it is
automatically added to the SQL Project Explorer.

To edit an existing file

Use Data Source Explorer or Project Explorer to navigate to the code you want to modify
and double-click it.

An instance of SQL Editor appears in the Workbench, populated with the extracted code of
the specified object or SQL project file.

CODE EXTRACTION

SQL Editor provides the ability to extract the underlying SQL code of database objects
registered in DB Optimizer to provide a front-end application for the development and
modification of data sources in your enterprise.

To extract underlying SQL code

Navigate to a database object in Data Source Explorer and select Extract via the right-click
menu.

The object’s underlying SQL code appears in SQL Editor and is ready for editing and further
modification.
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CODE HIGHLIGHTING

SQL Editor identifies commands and provides syntax highlighting changes that are
automatically added to the code as you add lines, which enables you to clearly and quickly
understand code when you read it in the interface.

The following syntax highlighting is automatically added to lines of code in SQL Editor:

Code Formatting
Comments green italics
SQL Commands dark blue
Syntax Errors red underline
Coding Errors red

Additionally, SQL Editor provides a purple change bar in the left-hand column that indicates if a
line of code has been modified from the original text. You can hover over this change bar to view
the original code line. A red square icon in the right-hand column indicates that there are errors
in the code line. You can hover over the icon to view the error count.

= 52

job CHAR (8) MOT NULL,
sal NUMERIC (38, 0) NOT NULL,
loc NUMERIC (38, 0) NOT NULL,

COMSTRAINT pjob PRIMARY FEY CLUSTERED (job)

(TS
]

IF OSJECT_ID('dbo.benson®) IS5 NOT NULL

yl

The purple change bar indicates if a line of code has been changed from its original text. Hover your mouse over the change bar to
view the original text.

AUTOMATIC ERROR DETECTION

The automatic error detection functionality of the editor highlights errors and typos in the code
as you work in “real time".
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Automatic error detection automatically identifies and analyzes SELECT, FROM, WHERE,
GROUP BY, HAVING, and ORDER BY statements. If it detects any syntax errors while you type
these statements, the line is automatically flagged by the error icon in the left-hand column of
SQL Editor. You can hover your mouse over the icon to view any errors.

| 5% "Benson.sql =
“CREATE TABLE dbo.benson il
{
job CHAR (8) NOT NWULL,
=al HUOMERIC (38, 0) HOT NULL,
loc HOMERIC (3B, 0) HWOT NULL,
CONSTRAINT picb PRIMARY EEY CLUSTERED (job)

go
IF D-BE-:T_I]:IL':"EI:'::“.D?T..-?.".'.’] I5 NGT WNULL
PRINT '«<<« CREATED TABLE dbo.benson >>>'
I ELSE
% ln unexpected token ™ < <> >™ was found. Expected COLON On

Syntax errors are automatically flagged by line as you work with code in SQL Editor. Hover the mouse over the error icon to view the
specific error message.

Additionally, all semantic errors are recorded in the Problems view, an interface component that
automatically logs errors and warnings as you work with files.

*{ Problems &3 1 ShRASTE
3 errors, 0 warnings, 0 infos
Description Resource 2ath Locaton
= B Errors (3 itemns)
3 An unexpected token “< << FAILED CR Benson.sql S0L Project 1 m= 14
& An unexpected token ™ was found. Bxg Fie. sl SOL Project 1 ine &
3 Table benson cannot be resolved on 'da Benson.sql SQL Project 1 e 19

The Problems view logs errors and warnings as you work with files in SQL Editor.

You can double-click on a line in the Problems view and DB Optimizer will automatically
navigate you to that issue in SQL Editor.

DB OPTIMIZER XE4/3.7 QUICK START GUIDE 51



SQL Code Assist and Execution

CODE COMPLETE

SQL Editor provides suggestion capabilities for both DML statements and objects. It has the
ability to look up object names in order to avoid errors when defining table names, columns, etc.
in the development process. This feature provides lists of object and code suggestions that will
make the development process more efficient as you will not be forced to manually look up
object names and other statement values. SQL Editor provides code assist for SELECT, UPDATE,
INSERT, and DELETE statements (as well as for MERGE statements on SQL Server 2008 and
higher) and object suggestion support for tables, alias tables, columns, alias columns, schemas,
and catalogs.

To activate code assist

1 Click the line on which you want to activate the code assist feature.

2 Press CTRL + Spacebar on your keyboard. Code assist analyzes the line and presents a list
of suggestions as appropriate based on the elements of the statement.

HYPERLINKS

Hyperlinks are used in SQL Editor to provide links to tables, columns, packages and other
reference objects. When you select a hyperlinked object from a piece of code, a new editor
opens and displays the source. Additionally, hyperlinks can be used to link procedures or the
function of a call statement, as well as function calls in DML statements. To enable a hyperlink,
hover your mouse over the object name and hold the CTRL key. It becomes underlined and
changes color.
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CODE FORMATTING

Code formatting is automatically applied to a file as you develop the file in SQL code. This
enables you to set global formatting preferences one time, and then apply them to all code
development, saving time and allowing for a more efficient code development process. The
code formatter can be accessed by selecting CTRL + Shift + F in the editor. All code is
automatically formatted based on parameters specified on the Code Formatter node of the

Preferences panel. (Select Window > Preferences in the main menu to access this panel.)

& NCes —
o - o
type filter text Code Fo e o
4 Hel o select a profile:
*! D
&l Install Lpdate Embarcaders [builtn] v [ show... |
#l- License NEI‘IEQEF o - :
= Run/Debug -W -_pur
=1 50 Development Preview:
Keehe Conbgms CREATE TABLE colTable .
Logging j
=I- 0L Editor s e
Code Assist = -1“1- ’
Code Formatter col2 INT,
Riesuits Viewsr cold INT,
Synitax Coloring col4d VARCHAR (30) =
50L Execution I+
S0L Fitters
2/ Team INSERT
INTO colTable
VALUES
(
5 ¥
g r
g,
'teat v]
[Restore Defauits | [ Apply |
G I Ok ] i Cancel ]

Code formatting parameters can be globally set and then applied to all development work in SQL Editor.

In addition to formatting code per individual file, you can also format an entire group of files
from Project Explorer. Select the directory of files that you want to apply formatting to and
execute the Format command from the right-click menu. The files will be automatically
formatted based on the global preferences.
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CODE FOLDING

The code folding feature automatically sorts code into a tree-like outline structure in SQL Editor.
This increases navigation and clarification capacities during the code development process. It
ensures that the file will be easily understood should any future work be required on the code.
As you work in SQL Editor, collapsible nodes are automatically inserted into the appropriate
lines of code. Statements can then be expanded or collapsed as needed, and this feature is
especially useful when working on parts of particularly large or complicated files.

CoODE QUALITY CHECKS

On Oracle-based code, the code quality checking feature provides suggestions regarding
improved code on a statement-by-statement basis. As you work in SQL Editor, markers provide
annotations that prevent and fix common mistakes in the code.

Notes regarding code quality suggestions appear in a window on any line of code where the
editor detects an error, or otherwise detects that the code may not be as efficient as it might be.
Code quality check annotations are activated by clicking the light bulb icon in the margin, or by
selecting Ctrl + | on your keyboard.

The following common errors are detected by the code quality check function in the editor:

e Statement is missing valid JOIN criteria

Invalid or missing outer join operator

Transitivity issues

Nested query in WHERE clause

Wrong place for conditions in a HAVING clause

Index suppressed by a function or an arithmetic operator

Mismatched or incompatible column types
e Null column comparison
To activate code quality checks:
e Click the light bulb icon in the margin of the editor or select Ctrl + | on your keyboard.

The editor suggestions appear in a window beneath the selected statement. When you click
a suggested amendment, the affected code is automatically updated.

SQL EXECUTION

When you have finished developing or modifying code, you can then execute the file from within
the DB Optimizer environment, on the database of your choosing. This enables you to
immediately execute code upon completion of its development. Alternatively, you can save files
for execution at a later point in time.
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In order to execute a file, you must first associate it with a target database. This is performed by
using the drop-down menus located in the Toolbar. When a SQL file is open in the Workbench,
the menus are enabled. Select a data source and a corresponding database to associate the file
with and then click the green arrow icon to execute the file.

5ol Untitled SQL.sgl 5% & -
b '} Orace b P TORLABSCORCL (MOVYIES) (10.2.0.1) B g -]
|l

=I-l=F Data Source Group

+-l=F Microsaft SOL Server

=I-1=F Oracle
ﬁEjROMLAEORCLﬁ_l
i ROMLABORCLSI_Z =
i sFvpclb0l embarcadera.com
ﬁijTORLﬂEORCLﬁ_2
ﬁLJTORLAEORCLﬁ_l
S TORLABSCORC
= CLf

+-1=F Microsoft SOL Server

cs.phone between 9625569900 and 99932569200 and
round [(ri.rentalid) > 10 and
trunc (ri.itemnurdkber) > 1 and
wE.totalecharge > (Sselect avy [(Cotalcharge)
from MOVIES.movierental) and
ri.moviecopyid not in (Select mo.moviecopyid w

Code

The pair of drop-down menus indicate that the SQL file is associated with the dataotb 19 data source and EMBCM database. When the
green arrow icon on the right-hand side of the menus is selected, the file is executed on the specified data source and database.

Additionally, if you have turned off auto-committal in the Preferences panel (Window >
Preferences) you can commit and execute transactions via the Commit Transaction and Start
Transaction icons located beside the Execute icon.

EXECUTE A FILE

Open the file you want to run and ensure it is associated with the correct database, then click the
Execute icon [[=] . DB Optimizer executes the code on the database you specified.
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EXECUTE A TRANSACTION

Open the transaction file you want to run and ensure it is associated with the correct database,
then click the Start Transaction icon [ & ]. DB Optimizer executes the transaction on the
database you specified.

COMMIT A TRANSACTION

Open the transaction file you want to commit, ensure it is associated with the correct database,
and click the Commit Transaction icon [. & ]. DB Optimizer commits the transaction on the
database you specified.

CONFIGURING SQL EXECUTION PARAMETERS

Use the SQL Session Options dialog to modify the configuration parameters that determine
how DB Optimizer executes code. These options ensure that code is executed the way you want
on an execution basis, ensuring accuracy and flexibility when running new or modified code.

& SOL Session Options

S0L Session Options
Specify the S0L sessian opkions Far the current editor,
Properky Yalue
—| Resulk Set
Maximurm Foves in Resulk Sek ]
Maxirmurn Mumber of Bytesina ... 2048
Query Timeout (seconds) 0
—| Transactions
AukaZarrmik frue
.
@_,J Finish l [ Cancel

SQL Sessions Options provide you with the flexibility to adjust execution parameters on a session-by-session basis.
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MODIFY SQL SESSION OPTIONS

1 Click the SQL Session Options icon on the toolbar. The SQL Sessions Options dialog
appears.

2 Click on the individual parameters in the Value column to change the configuration of each
property, as specified.

3 Click Finish. The session options are changed and DB Optimizer executes the code as
specified by your options.

NOTE: SQL Session Options are only applied to the currently-selected code, and are not
retained across different files with regards to execution.
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